


Add/Edit Content





	
      << Click to Display Table of Contents >>

      Navigation: 
      
      Appendix >

   
      Add/Edit Content


    	
      
      
      
      
      
    





  


 




 

[image: editor.icon] Add/Edit Content

 


 

A range of options to add and edit content is available in PDF-XChange Editor. These options are available in the Home tab:
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Figure 1. Home Tab, Content Editing Tools

 

These tools are used to edit the base content of documents and add text, images and barcodes to the base content layer. Please note that the Content pane is a useful feature to use in conjunction with the content editing tools. 
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Click Edit Content to select and edit document content:
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Figure 2. Edit Content Tool

 

Click the Edit Content dropdown menu to view content selection/editing options:
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Figure 3. Home Tab, Edit Content Tool, Content Options

 

•Click All Content to select/edit text, images and shapes simultaneously when the Edit Content tool is enabled.
•Select Text to edit only text when the Edit Content tool is enabled.
•Select Images to edit only images when the Edit Content tool is enabled.
•Select Shapes to edit only shapes when the Edit Content tool is enabled. Shapes are defined as paths, shading, XForms and all other document base content that is neither text nor imaged-based.
•Enable/disable the Edit Text Elements as Blocks option as desired. This feature recognizes blocks of document text and enables their group-selection for editing.
 

When the Edit Content Tool is selected, click to select content items, or click and drag to group-select content items. Note that group-selected items are edited simultaneously. Selected content items appear as below:
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Figure 4. Selected Content Item

 

•Click and drag the yellow control points to resize content. 
•Click and drag the circle at the center to reposition content.
•Click and drag the green control point at the top to rotate content items. Hold down Shift to rotate at increments of fifteen degrees.
•Use the arrow keys to reposition content. Hold down Shift to move at an increased increment.
•Use the editing aids detailed here to assist in the precise placement of document content.
•Press Ctrl+' to open the Properties pane for selected content and view/edit properties. Note that not all properties are editable.
•Click the Format tab to format selected content, as detailed below:
 

Format Tab for Images
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Figure 5. Format Tab for Images

 

•Use the Opacity dropdown menu to determine the transparency of the image.
•Use the Blend Mode to determine the blend mode used when content overlaps with other content, as detailed here.
•Click Edit to edit the image in either the default application for editing images or an alternative application.
•Click Save to save the image to file.
•Click Recompress to recompress the image, as detailed below.
•Click Replace to replace the image with an alternative image.
•Click OCR to perform optical character recognition on the image.
•Click Properties to view/edit the properties of the image.
 

Format Tab for Text

 

[image: format.tab.text.ribbon]

Figure 6. Format Tab for Text

 

•Use the Fill Color dropdown menu to determine the color of the text.
•Use the Stroke Color dropdown menu to determine the border color of the text.
•Use the Width dropdown menu to determine the width of the Stroke Color.
•The Border option is not available for text.
•Use the Opacity and Stroke Opacity dropdown menus to determine the level of transparency of the Fill Color and Stroke Color respectively.
•Use the Blend Mode to determine the blend mode used when text overlaps with other content, as detailed here.
•Use the Font and Font Size settings to determine the font used and the size of the font.
•Use the Bold, Italic and Alignment options to enable/disable bold and italic and/or adjust the alignment of text as desired.
•Use the Grow Font and Shrink Font options to increase/decrease the size of the font.
•Click Properties to view/edit the properties of selected text.
 

Format Tab for Shapes
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Figure 7. Format Tab for Shapes

 

•Use the Fill Color dropdown menu to determine the color of the shape.
•Use the Stroke Color dropdown menu to determine the border color of the shape.
•Use the Width dropdown menu to determine the width of the Stroke Color.
•The Border option is not available for shapes.
•Use the Opacity and Stroke Opacity dropdown menus to determine the level of transparency of the Fill Color and Stroke Color respectively.
•Use the Blend Mode to determine the blend mode used when shapes overlap with other content, as detailed here.
•Click Properties to view/edit the properties of selected shapes.
 

Right-Click Options Menu

 

Right-click content for further options. Please note that available options depend on the format of selected content. The menu below contains all available options:
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Figure 8. Content Items Right-Click Menu

 

•Hover over Edit Image to view editing options for images:
•Click Default Application to edit the image in the default application for editing images. Note that changes made to images in the application will be updated in the current document when the image is saved.
•Click Open With to select a non-default application with which to edit the image. The Open with dialog box will open. Selected the desired application and click OK to launch it.
•Click Edit/Save Images Without Display Transformations to enable/disable this feature. When it is enabled, images can be edited/saved in the state that they were in when added to the document. All subsequent rotations, transformations and scaling operations applied to the image/page are ignored.
•Click Replace Image to replace selected images with an image from file. Note that replacement images are automatically scaled to match the dimensions of images that they replace.
•Click Recompress Image to recompress images, as detailed below.
•Click Save Image As to save a copy of selected images to file. The Save File As dialog box will open. Enter a file name in the File name text box, then click Save to save the image.
•Click OCR Image to perform optical character recognition on selected images. The OCR Image dialog box will open. Select the desired language and accuracy then click OK to perform OCR.
•Click Add Boomark to add a bookmark at the selected location. Further information on bookmarks is available here.
•Hover over Add Link to view the options for adding links:
•Click Add Goto Link to create a link from the selected location to a location within the current document. The Browse for Link Target dialog box will open. Move to and select the desired document location and then click Set Link to create the link.
•Click Add Weblink to create a link from the selected location to an internet location. The Add Action: "Open a Web Link" dialog box will open. Enter the desired URL in the text box and then click OK to create the link.
•Click Add Open File Link to create a link from the selected location to a file on the local computer. The Add Action: "Open a File" dialog box will open. Determine options as detailed here then click OK to create the link.
•Click Add Custom Link to create a custom link. Custom links can be used to create a range of dynamic links, such as links that launch JavaScript actions, move to pages in other documents, open files, execute PDF-XChange Editor commands, reset/submit forms, play sounds and show/hide form fields. The Edit Action List dialog box will open. Determine options as detailed here then click OK to create the link.
•Click Hand Tool, Snapshot Tool, Select Text or Zoom In/Out Tool to enable these tools.
•Click Cut, Copy, Paste, Delete or Deselect to perform these actions on selected content.
•Hover over Arrange to view arrangement options for selected content:
•Use the Align options to align selected content items.
•Use the Distribute options to distribute selected content items evenly on the horizontal or vertical axis as desired.
•Click Make Same Width/Height/Size to make selected content items the same width/height/size as desired.
•Use the Rotate/Flip options to rotate/flip selected content.
•Click Transform to edit the position, size and/or rotation of selected content, as detailed here.
•Click Duplicate to to duplicate selected content items, as detailed here.
•Click Bring Forward to bring content items forward one step in cases of multiple items overlapping.
•Click Send Backward to send content items back one step in cases of multiple items overlapping.
•Click Bring to Front to bring content items to the front in cases of multiple items overlapping.
•Click Send to Back to send content items to the back in cases of multiple items overlapping.
•Click New Stamp from Selection to create a new stamp from selected content, as detailed here.
•Click New Document from Selection to create a new document from selected content. The new document will open in a new window in PDF-XChange Editor.
•Hover over Export to view export options for selected content, then click Export Selection to Microsoft Word Document/Excel/Powerpoint Presentation as desired. The Save File dialog box will open. Enter a name/location for the new file and then click Save to export the content.
•Click Properties to open the Page Content Properties pane for selected content. This pane is used to view/edit content properties, as detailed here.
 

Recompress Images
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Figure 9. Recompress Image Dialog Box

 

•Use the Conversion Options dropdown menu to select a new compression format for images. Note that the selection made in this dropdown menu determines the options for the two dropdown menus below.
•Use the Compression Options dropdown menu to select a new compression format for images.
•Use the Downsampling Options dropdown menu to determine downsampling options as desired. The X and Y text boxes determine the downsampled resolution on the X and Y axes respectively.
•Select the Replace current instance only text box to replace only the current instance of the image in documents where the same image is used multiple times.
 

Note that the values in the Image Details pane display details about the current image and the image after compression has taken place using the values entered in the Recompress Image dialog box. Additionally, the preview pane will update according to any changes made.
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Click Add to add content to documents:
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Figure 10. Tools Tab Submenu. Content Editing Tools, Add Options

 

These options are used to add text, images and barcodes to documents:
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Click Add Text to add text to documents: 
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Figure 11. Home Tab, Add Content Options

 

When this feature is selected the pointer will become a cross icon. Move the icon to the desired location and click to designate the location of the new text box. Text can then be entered as desired:
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Figure 12. Add Text Tool Example

 

•Click and drag the central yellow control points on either side of text boxes to resize them horizontally. (Note that it is not possible to resize text boxes vertically until text has been entered into them).
•Click and drag the green control point to rotate text boxes. Hold down Shift to rotate at increments of fifteen degrees.
•Use the editing aids detailed here to assist in the precise placement of text boxes.
•Enter the desired text in the text box. Press Enter to start new lines. The options in the Format tab can be used to adjust the text style, as detailed above.
•Right-click text for further options:
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Figure 13. Editing Options

 

•Click Undo to reverse the most recent action.
•Click Cut to cut selected text to the clipboard.
•Click Copy to copy selected text to the clipboard.
•Click Paste to paste current clipboard text at the selected location.
•Click Select All to select all text in the selected area.
•Click Paragraph to edit paragraph settings, as detailed in (figure 14).
•Click Text Style to update the style of selected text. The following options are available:
•Bold
•Italic
•Underline
•Superscript transforms selected text into superscript, which is used for specific purposes such as detailing chemical compounds.  
•Subscript transforms selected text into subscript, which is used for specific purposes such as detailing mathematical formulae.
•Clear Text Formatting clears formatting from selected text.
•Make Current Text format Default sets the format of selected text as the default format for subsequent text. 
•Apply Default Text Format applies the default text format to selected text.
•Select Hyphenate Text to hyphenate text automatically when it crosses line endings.
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Figure 14. Paragraph Options

 

•Use the Alignment menu to determine the alignment of paragraphs.
•Use the Indentation number boxes to determine the indentation from the left and right margins, and the Special and By menus to determine hanging options. 
•Use the Spacing options to determine line spacing.
 

Click OK to save paragraph settings.
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Click Add Image to add images to documents:
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Figure 15. Tools Tab Submenu. Add Image Tool

 

The Select Image Placement Tool dialog box will open. Click Drag Image Rectangle, then click and drag to determine the location at which the image is inserted. The Open Files dialog box will open. Select an image from the local computer. The Add Image dialog box will open:
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Figure 16. Add image Dialog Box

 

•Click the folder icon to select an alternative file.
•Select an option to determine how the image is added: 
•As a Stamp adds images as stamp annotations, as detailed here.
•As a Content Item adds images as content items.
 

Please note that stamps and content items feature different editing options.

 

Click Place to add images.
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Barcodes provide a useful method for the storage of information that barcode readers and mobile devices such as smartphones and tablets can access. Click Add Barcode to add barcodes to documents:
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Figure 17. Add Submenu. Add Barcode

 

The Select Barcode Placement Tool dialog box will open when. Click Drag Barcode Rectangle to add a new barcode. The pointer will become a crosshairs icon. Click and drag to determine the size and location of the barcode. The Add Barcode dialog box will open:
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Figure 18. Add Barcode Dialog Box

 

•Use the Data type menu to set the format of the data contained in the barcode:
•Contact (vCard) is a file format standard that is used to store electronic business cards.
•URL is used to store internet addresses.
•Free Text is used to store text-based content.
•Email is used to store information in email format.
•Barcodes are created automatically when data is entered in the text fields, and can be viewed in the Image preview pane.
•Select either As Stamp annotation or As part of page's content to determine how barcodes are added to documents. Please note that stamp annotations and page content have different editing options.
•Select either As Vector or As Image as desired. If the Image option is selected then use the dpi number box to determine the barcode resolution.
•Select the Add Margin box to add a margin to barcodes.
•Use the Fill color and Barcode color palettes to determine the colors used for barcodes.
 

Click Place to add the barcode to the document.
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